CH 3.0.0

User’s guide for CH Server

Programmer: Claude Hanssens

Basic description of CH Programs 3.0

This program has been developed for Microsoft Flight Simulator on the Internet or a local network.  It is also possible to use CH Programs on a single computer or over the Internet.

The program is actually composed of 3 separate programs:

· The CH Client 3.0

· The CH Server 3.0

· The CH Data Manager 3.0

The CH Client takes information from Flight Simulator 98, 2000, or 2002 and sends it to the CH Server through a TCP/IP network. The CH Server displays the information received from the client’s flight simulator through CH Client. The information in CH Server will be displayed in a tabular format on a special form. Another form will show the aircraft on a radar screen. This radar screen will also display other information like NAVAIDS (VOR, NDB, frequencies...), geographical data and airports. This information is taken from a Microsoft Access database. The CH Server part has also the capacity to generate “Devil orders”. These are commands sent to the flight simulator when connected.  The server can manipulate the weather environment, aircraft systems, position and navigational equipment.  CH Server has been designed to act as a host and a server client.  People can use the program to connect multiple pilot and air traffic controller users into a network.

Limitations of design

CH Programs has been developed to support the needs of our fans through feedback.  The design and functionality were developed for a specific use. If you decide to use CH Programs outside the original design, it may work or it may not, or you won’t be able to use it to the full extent.

The main ideas on which CH Programs are based are:

· CH Programs 3.0 was designed for use on the Internet or through a Local Area Network. This has a few consequences.

· The installation and testing can be done while the users have direct contact: they can talk directly with each other.

· There are no vocal radio communication features included in CH programs. You must own a separate radio communication system.  Roger Wilco is the preferred choice.

· CH Programs 3.0 was designed for use by PC and Flight Simulator Power users. 

· Version 3.0 now has an automatic install feature, but there might be some configuring required which will be discussed later. 

· It requires a fully operational TCP/IP network. The users must be able to set up such a network and be able to coordinate the availability of service. In a club, there is generally at least one person able to do so.

· Users must have knowledge in interoperating earth geographic coordinates, weather data, and aerodynamics.

· Must have knowledge concerning the capabilities of Microsoft Flight Simulation: weather settings, aircraft settings, ect.

Version and Upgrade

Actual version of CH Server is 3.0.0.

There will be upgrades to this version.

These upgrades can be minor upgrades, major upgrades or fully new version.

CH Client V3.0.0 is only compatible with CH Server V3.0.0.

Changes since version 2.0.0

Radar

Added a Save feature allows users to save a radar screen

Added an Open feature allows users to open a saved radar screen

Modified the default size setting of the radar screens; are no longer maximized

Added a combo-box to easier select an H range

Added the ability to display frequencies of NAVIADS (VOR, NDBs, ect)

Added a tracking feature

Modified the aircraft information radar display as a square box with exact heading line

PAR

Added distance from touchdown lines

Modified the aircraft information radar display as a square box with exact heading line

Profile view

Added a new screen

Aircraft Info

All tabs have been adapted to match Microsoft Flight Simulator 2000 and 2002
(items have been added, removed or adapted)

Server Info

Added an Id text box and a login with security check to the server

Added a Group/individual text box for ATC to ATC or ATC to Pilot communication

Devil Weather

Weather (Global) interface has been adapted to match Microsoft Flight Simulator 2000 and 2002
(items have been added, removed or adapted) 
Removed tabs Weather (Area 1) and Weather (Area 2)

Devil Settings

Modified all tabs to match Microsoft Flight Simulator 2000 and 2002 
(items have been added, removed or adapted)

Security

Added a new screen

General

Re-designed the program to improve support and compatibility for FS98.
Added an optional security option with a login and permission function poll upon connection

Added the ability to enable or disable detection of aircraft and server connections

Added an .ini file to define start-up defaults

Modified technical features

Distribution

CH Programs is available:

· for download on the Internet

· on CD-Rom (made on request only by Claude Hanssens)

Both versions have exactly the same functionality.

The CD-Rom version also includes:

· Sound files

Installation of CH Server

CH Server 3.0
If you have any previous version of the CH Server, you must first uninstall it:

· Start-Settings-Control Panel-Add/Remove programs

· Click on “CH Server”, if in the list.

· Click on the "Remove" button.

To install CH Client, simply run the “Setup” program.  After install is complete, you might have to
restart your computer.

Connecting aircraft and server clients to a network

1)  To run the program and connect aircraft and radar services together, you must first choose one computer that will play the role as the “Main Server”. All aircraft and CH Server clients will connect to that computer. That computer must have CH Server installed. There is no special version of CH Server, you just need to decide which one will act as the Main Server; the other servers will use the “Connect to Server”option. You need to know the computer name or IP address of the Main Server.

Remark: When a single-computer is used, simply execute all the procedures on the same computer.

To start as the Main Server:

· In the Start-Programs menu, click on the icon for CH Server

· In the CH Server, click on “Connection”, then click the “Act as Main Sever” option.

2)  Once the Main Server is running, you may connect the other servers (server clients) to it.

· Under Windows Start-Programs menu, click on the icon CH Server

· After starting CH Server, click on “Connection”, then on “Connect to Main Sever”

· An Input box will ask for a Computer name or IP address.  Fill-in the name or IP address of the Main Server

· If the connection is established, the Main Server will display a message saying “Opening Server connection number X”. You will see this message for each Server you connect to the Main Server

Repeat this sequence for additional CH Server client connections.

Note: the Server will display a message stating it established the connection.  You can verify that you have a connection to the main server by clicking on “Form”, then “Server Info” and verify that the IP or computer name of the main server is indicated in the “host name” box.

3) Once the Main Server is running, pilots may connect using the CH Client to it.

· Start Microsoft Flight Simulator

· In the Start-Programs menu, click on the icon for CH Client

· After starting CH Client, type your call-sign in the “Call-sign” text box

· In the CH Client Id box, type your Id (if the connection requires it, otherwise leave as CHPilot

· Click on “Connect to FS”

· CH Client will display a message saying that you are connected to Microsoft Flight Simulator

· Click on “Connect to Server”

· An Input box will ask for the Computer name or IP address: fill-in the name or IP address of the Main Server

· If the connection is established, the Main Server will display a message saying “Opening Aircraft connection number X”. You will see this message for each plane you connect to the Main Server

· If you want, you may select a higher interval in the “Send info every” 
(Default every second)

· Minimize the CH Client and fly normally.

Repeat this sequence for every CH Client.

Note: the CH Client will display a message stating it established the connection.  After a few seconds, if CH Client cannot establish the connection, it will display a message AND display a message in Microsoft Flight Simulator.

User’s guide

General

The CH Server may be installed on another computer or on the same as the host.  You can use Microsoft Flight Simulator and the Server on the same computer, but you do not need Microsoft Flight Simulator or FSUIPC on that computer to use the program.  CH Server plots and tracks aircraft on a radar screen.  It takes the aircraft data and sends it to the operator. 

When the program is started, it will look like this:
(See example below)
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To receive aircraft information, one Server must be declared as “Main Server”. Then the aircraft must connect to that server. The server clients may also connect to the Main Server, proving a multi-radar network.

The “Connection” menu allows to:

· Act as main Server: receive information from aircraft and send it to other Servers; to receive orders from Servers and send it to aircraft

· Connect to Main Server: receive information from the aircraft through the Main Server or send orders to aircraft through the Main Server

· ATC to ATC and ATC to Pilot Communication (see Communication chapter)

To declare a CH Server as a Main Server:

· In the Connection menu, check “Act as Main Server”.

To close the session:

· In the Connection menu, uncheck “Act as Main Server”.  A warning will then be displayed confirming the disconnect request.
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To connect a CH Server to the Main Server:

· From the Connection menu, check “Connect to Main Server”.

· Type in the Computer Name or the IP address of the Main Server when prompted
(See example below).
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· Click OK

To Disconnect from the Main Server:

· In the Connection menu, uncheck “Connect to Main Server”.  A warning will be displayed confirming the disconnect request.

Each Server will see the information of all aircraft connected.  All aircraft can receive orders from the Main Server and the other Server clients.

On each connection (from plane or Server), the Main Server will display a message 
(unless specifically set not to):
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When all aircraft and servers clients are connected to the Main Server, the network is ready.

Remark: all of the following items are available for the Main Server and connected server clients:

The Form menu proposes the following choices:

· Radar

· New PAR

· New Profile view

· Aircraft Info

· Sever Info

· Devil Weather

· Devil Settings

· Security

· About: displays the “About” screen

· Exit: to close the Server

(See example below)
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Aircraft Info

This is the fourth item in the Form menu.

In the “Aircraft info” menu, the upper part of the screen contains:

· the “Request” button: requests the selected information from plane: the controller makes a selection or and then requests them all together. The Request button works only for the current tab (see below).

· The combo box “Request”: allows the controller to choose which aircraft information to be requested (the “Request” combo-box is not available on the Aircraft info tab).

The remaining portion of the screen is separated in 5 tabs:

· Aircraft info

· Weather/World

· Settings/Failure

· Autopilot/Com

· Aircraft controls (Engines)

· Aircraft controls (Others)

Aircraft info tab

1) Upper part

The upper part of the screen is a table where the most important information is displayed. This table shows the following information about the connected planes:

· Call-sign

· Squawk

· Latitude

· Longitude

· Altitude MSL

· Altitude AGL

· TAS

· Course

· Host Name

· IP address

(See example below)

Remark: geographical coordinates are always formatted   00°   00.00’
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The data displayed is automatically updated upon reception from CH Client. The CH Client user selects the update interval.

The Request button will clear data from disconnected aircraft (Refresh mode).

You may have one or more blank lines if connections have been opened and closed and have not been re-used.

1) The left lower part will show all “timed orders” (see Devil Settings chapter) sent to planes (orders sent once are never shown). The information is:

· Call-Sign

· Comment about the devil’s order

· Interval (if interval is empty, this order has been stopped)

The “Stop this!” button allows the controller to stop the selected order
(the items requested must be selected first).

The “Stop all!” button allows the controller to stop all orders.
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2) The right lower part is only available if you’re the Main Server. The list shows the connected aircraft and their handling radar (see Radar-Hands off chapter).
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The “Free all!” button allows the controller to free all planes (the planes will become grey without server name on all radar: see Radar-Hands off chapter).

Remark: although CH Server seems to work correctly on Windows NT/2000. I noticed that the Aircraft info screen hangs on Windows NT Server 4.0.

Weather/World tab

This tab will display the current weather environment around the aircraft and some information about the it’s position.
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To receive information from an aircraft:

Select the desired aircraft callsign in the Request combo-box

Click the Request button

The information will be displayed a few seconds later. As soon as all information is displayed, the “Info from” area is displayed with the callsign of the requested aircraft and the time the information arrived:
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Remark 1: Information is NOT automatically updated. You MUST click the “Request” button to update the information.

Remark 2: Some temperature, cloud or wind layers are filled with 0 or negative value. This means the layer does not exist.

Remark 3: Although some areas can be modified-- that information is read-only.

Remark 4: Sometimes, the aircraft does not respond to the Server request. You may have to click twice to get full information.

Settings/Failure tab

This tab will display the current settings and failure status of the plane.

(See example below)
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To receive information from an aircraft:

Select the desired aircraft callsign in the Request combo-box

Click the Request button

The information will be displayed a few seconds later. As soon as all information is displayed, the “Info from” area is displayed with the callsign of the requested aircraft and the time the information arrived.

Remark 1: Information is NOT automatically updated. You MUST click the “Request” button to update the information.

Remark 2: Although some areas can be modified--that information is read-only.

Remark 3: Sometimes, the aircraft does not respond to the Server request. You may have to click twice to get full information.

Autopilot/Com tab

This tab will display the current settings of the autopilot and communiction radios.

(See example below)
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To receive information from an aircraft:

Select the desired aircraft callsign in the Request combo-box

Click the Request button

The information will be displayed a few seconds later. As soon as all information is displayed, the “Info from” area is displayed with the callsign of the requested aircraft and the time the information arrived.

Remark 1: Information is NOT automatically updated. You MUST click the “Request” button to update the information.

Remark 2: Although some areas can be modified--that information is read-only.

Remark 3: Sometimes, the aircraft does not respond to the Server request. You may have to click twice to get full information.

Aircraft controls (Engines) tab

This tab will display the current settings of the controls of the plane.

(See example below)
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To receive information from an aircraft:

Select the desired aircraft callsign in the Request combo-box

Click the Request button

The information will be displayed a few seconds later. As soon as all information is displayed, the “Info from” area is displayed with the callsign of the requested aircraft and the time the information arrived.

Remark 1: Information is NOT automatically updated. You MUST click the “Request” button to update the information.

Remark 2: Although some areas can be modified--that information is read-only.

Remark 3: Sometimes, the aircraft does not respond to the Server request. You may have to click twice to get full information.

Aircraft controls (Others) tab

This tab will display the current settings of the controls of the plane.
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To receive information from an aircraft:

Select the desired aircraft callsign in the Request combo-box

Click the Request button

The information will be displayed a few seconds later. As soon as all information is displayed, the “Info from” area is displayed with the callsign of the requested aircraft and the time the information arrived.

Remark 1: Information is NOT automatically updated. You MUST click the “Request” button to update the information.

Remark 2: Although some areas can be modified--that information is read-only.

Remark 3: Sometimes, the aircraft does not respond to the Server request. You may have to click twice to get full information.

Radar

This is the first item in the Form menu.
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The “Radar” menu allows to:

· Open a new blank radar screen (“New” option)

· Open a previously saved radar screen (“Open” option)

If the menu "Open" is chosen, a dialog box listing all previously saved radar screens are displayed:

(See example below)
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You may select the one you want:

· by double clicking on it

· by highlighting the file then clicking on “Open”.

Clicking the "Cancel" button will close the dialog box without opening a saved screen.

When opened, a radar file looks like the picture below:
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The Menu bar has the following areas:

· Center on combo-box: allows the controller to select an ICAO code. This code will be used as the center of radar screen (here EBBR) (see further).

· H Range combo-box: allows the controller to display a narrow or wide range on the screen (from 1 NM to 1000 NM) (here 50 NM) (see further).

· H Range scroll-bar: allows the controller to display a narrow (on the left) or wide (on the right) range on the screen (from 1 NM to 1000 NM) (here 50 NM) (see further).

· Options button: displays the Options Menu (see further).

· Save button: saves the current radar (see further).

Center on combo-box

In the “Center on” combo-box, you may

· Select an ICAO from the list

· Type it directly in the text area then press the “Enter” key.

If the code does not exist in the list, “CH Radar” will display a message, then blank the text area and the whole radar screen.

If “CH Radar” finds more than one occurrence of the code, it will display the whole list of corresponding data:

(see example below)
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You must select the one you want:

· by double clicking on it

· by using the arrow keys and then clicking on “OK”.

H Range combo-box and scroll bar

You can select the horizontal range (width displayed on the radar screen) by using the combo-box or the scroll bar.  Both controls are synchronized. The scrollbar is more accurate.

The title of the Window always displays the Center of the radar and the selected range.

Options button:

It will open the Options screen.
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This menu allows you to display or hide

· ARP: displays airport with airport ICAOs

· (Freq): displays the frequency (Tower) of the airport (if ARP is checked)

· VOR: displays VOR

· (Freq): displays the frequency of the VOR (if VOR is checked)

· NDB: displays NDB

· (Freq): displays the frequency of the NDB (if NDB is checked)

· FIX: displays fixes

· Runway (single): displays runways as a single line

· Runway (info): displays the ICAO code and the runway number (if Runway (Single) is checked).

· Runway (App): displays approach lines (10 NM) (if Runway (Single) is checked).

· Runway (det.): displays runways as rectangle

· Taxi: taxi-ways

· Airways (high)

· Airways (low)

· Airways (info): displays the name of the airways (if Airway is checked)

· Geo: geographical data's

· Relief: mountains

· Road

· Water: lakes, seas

· Building

· Custom: can be used to stored any other type of information

· Boundary: controlled areas boundaries

· Labels: displays information labels

· Filter: hides aircraft's below or above chosen altitudes

· Tracking: plots the course of the aircrafts

· Hands off: see further

· Save mode: see further

· Radar circle: circles around the center to measure distance (user can choice the distance between the circles)

· Colors…: see further

The Apply button applies the change and closes the Options menu.

To help you:

· “CH Radar” will adapt the radar screen only if there is a center selected. It is sometime faster to clear the “Center” combo-box, to select the range, to choose the options (all this without refresh of the screen) and then re-select the center.

· If you wish to refresh your radar screen, click in the “Center” combo-box en press the “Enter” key.

Hands off:

This feature helps two controllers manage aircraft on the Radar screen.

When this option is checked in the “Options” menu, the text information of a plane is gray the first time it is appears on a Radar screen (note that the plane itself is always yellow).

Example:

· “CHControl” (on PC1)

· “CHControl 2” (on PC 2)

· “CH-006” (on PC3)

Remark: the name of a server is described in the screen “Server info” (see Server Info chapter).

a) The plane appears gray without server name in his text information. The plane is not controlled.
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This image depicts the aircraft as not controlled.
b) When double-clicked on PC1, the text information becomes yellow and the name of the server PC1 is displayed. On PC2, the text information appears grey and the name of the server PC1 is displayed. If the text information is double-clicked on server PC2, a message appears, stating that another server controls the aircraft.
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The image indicates that the aircraft is controlled by CHControl
c) When double-clicked again on PC1, the text information remains yellow but the name of the server is no longer displayed. On PC2, the text information appears grey and the name of the server PC1 is no longer displayed.
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The aircraft is released by CHControl (current server).
c) When now double-clicked on PC2, the text information becomes yellow and the name of the server PC2 is displayed. On PC1, the text information appears grey and the name of the server PC2 is displayed. If the text information is double-clicked on server PC1, a message appears, saying that another server controls the plane.
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The aircraft is controlled by CHControl 2 (another server).
If an aircraft is handled by a Server and this Server leaves the network, the plane will remain handled by this Server. To free this plane, you must go into the “Aircraft info” form (See Aircraft Info chapter).

Save mode:

When this option is checked, a point or a line can be saved directly into the CH Database from the Radar screen.

Remark: do not mix the Save mode in the Options menu (allowing to save data in the CH Database) and the Save button in the menu bar (allowing to save the definition of a radar screen: see further).

To save a point or a line:

· Mark the “Save mode” check-box

· Press the “Shift” key

· Click the Radar screen for a point

or

· Draw the line on the Radar screen

· Release the “Shift” key. The following screen appears:

(See example below)

[image: image24.png]Save line

Neme [Fogorine | T [i05TT 2]
Orgn
L v 50 [o0r
Longiude £ & iezs
B

Loude [V [0 [0 save
Lorgtude £ [¢ 22 =





· If you wish, type a new name in the “Name” text-box

· If you wish, select a new type in the “Type” combo-box

· Click “Save” to save the point or the line and close the screen

or

· Click “Cancel” to close the screen without saving the line

Note: you are not allowed to change the co-ordinates.

Colors…:

When clicked, the “Colors” button displays the following screen:
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· Select the color you want in the combo-boxes

· Click “Save colors” to save the colors in the CH Database. From then on, a new Radar will have the selected colors.

· Click “Apply colors” to apply the selected colors without saving them.

· Click "Cancel" to close the screen and keeps actual colors.

Save button

When clicked, the Save button will save the definition of the current radar screen so you can open it later.  It will display the following input box:
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· Type a filename for the radar file or keep the default one (the extension .chr will be added automatically)

· Click “OK” to save the radar screen

Or

· Click "Cancel" to close the input box without saving.

The radar file is saved in the same folder as is CH Server.

Miscellaneous

Plane representation:

Each aircraft has the following representation:

· The aircraft box and heading line

· The aircraft information box with

· Squawk / TAS

· Altitude in Flight Levels / Heading

· Call-sign
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The aircraft box is drawn at the actual position of the aircraft.

The heading line points towards the course of the aircraft.

The length of the heading line is related to the speed of the aircraft. The top of the heading line shows the position the aircraft will have one minute later (if the plane keeps the same speed and heading).

The heading line cannot be longer than one fifth of the screen and cannot be smaller than a few millimeters. If the aircraft is at full stop, a very short heading line shows the heading of the aircraft.

It is possible to move the information box of a aircraft by dragging it (but it will always remain around the arrow). So you can see information from two aircraft close together or above a NAVAID. Information box is linked to the aircraft by the dashed line.

Radar screen offset:

It is possible to move a point of the screen by dragging it: choose a point of the radar screen and drag it on the desired location.

Heading and distance:

By dragging with the right mouse button, the radar will display the distance and heading between 2 points:
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Multi-radar:

The menu “New Radar” allows the controller to open as many radar screens as he wants in one server. Each radar may have his own center, range and options. All screens are updated automatically. Switching from one screen (radar, AC Info or other) to another is done in the Window menu.

If the “CH Radar” is not maximized, you may see more than one window of the CH Server: Aircraft info, all radar screens, etc.  (See example below)
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Database:

The CH Database is a MS-Access 7.0 database, with separate tables, index, primary keys. The program always selects the minimum records required.

Examples of radar screens:

Example 1: Radar center: EBBR

ARP, VOR, NDB, FIX, Radar circle 30 NM, Geo, Boundary, Range 200 NM

[image: image28.png]12000





Radar Approach: VOR (Freq), NDB (Freq), FIX, Run (Single), Approach, Range 40
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Radar Ground: Runway (det), Taxi, Range 5 NM
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NEW PAR

This is the second item in the Form menu.

It will open a Precision Approach Radar.

The screen looks like the picture below:
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The screen is divided in three parts:

· the Side view

· the Plan view

· the Menu area

Side view

This is the upper part of the PAR screen.

It shows the runway, the ground, the glideslope and the ILS beam (0,7° above and below the glideslope).

A vertical line is drawn at every mile.

Plan view

This is the lower part of the PAR screen.

It shows the runway, the localizer and the ILS beam (2,5° on each side of the localizer).

A vertical line is drawn at every mile.

Menu Area

This is the upper left  part of the PAR screen.

It looks like below:
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In this area, you may select the runway. Below the runway, you may select the side of the runway (here above, runway 20 at EBBR).

The “Range” combo-box allows you to select the range of the PAR screen from 1 to 15 NM.

The “GS” text box displays the angle of the glideslope beam and is read-only. This data is stored in the CH Database. You may change the glideslope angle directly in the CH Database.

Each plane has the following representation:

· The aircraft box and heading line

· The aircraft information box with

· Squawk / TAS

· Altitude in Flight Levels / Heading

· Call-sign
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The aircraft box is drawn at the actual position of the plane.

The heading line points towards the course of the plane.

The length of the heading line is related to the speed of the plane. The top of the heading line shows the position the aircraft will have one minute later (if the plane keeps the same speed and heading).

The heading line cannot be longer than one fifth of the screen and cannot be smaller than a few millimeters. If the aircraft is at full stop, a very short heading line shows the heading of the aircraft.

It is possible to move the information box of a plane by dragging it (but it will always remain around the arrow). So you can see information from two aircraft close together or a aircraft above a NAVAID. Information box is linked to the aircraft by the dashed line.

IMPORTANT:

1. PAR radar has some special data requirements. Be sure to read carefully the remarks in the CH Data Manager doc file. If the data are not correctly filled out, then CH PAR will not work.

New Profile View

This is the third item in the Form menu.

It will open a Profile view.

The screen looks like the picture below:
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The Profile view is a vertical view of the airspace: west is on the right of the screen, east is on the left.

The line at the bottom of the Profile view is the Mean Sea Level.

Dashed lines are drawn at every 2000 feet's.

The Menu bar has the following areas:

· Center on combo-box: allows the controller to select an ICAO code. This code will be used as the center of the profile view (here EBBR) (see further).

· H Range combo-box: allows the controller to display a narrow or wide range on the screen (from 1 NM to 1000 NM) (here 50 NM) (see further).

· H Range scroll-bar: allows the controller to display a narrow (on the left) or wide (on the right) range on the screen (from 1 NM to 1000 NM) (here 50 NM) (see further).

· Options button: displays the Options Menu (see further).

Center on combo-box

In the “Center on” combo-box, you may

· Select a code from the list

· Type it directly in the text area then press the “Enter” key.

If the code does not exist in the list, “CH Profile” will display a message, then blank the text area and the whole radar screen.

If “CH Profile” finds more than one occurrence of the code, it will display the whole list of corresponding data:
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You must select the one you want:

· by double clicking on it

· by using the arrow keys and then clicking on “OK”.

H Range combo-box and scroll bar

You can select the horizontal range (width displayed on the profile view) by using the combo-box or the scroll bar.

Both controls are synchronized. The scrollbar is more accurate.

The title of the Window always displays the Center of the Profile view and the selected range.

Options button:

It will open the Options screen.
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This menu allows to display or hide

· ARP: displays airport with airport ICAO

· (Freq): displays the frequency (Tower) of the airport (if ARP is checked)

· VOR: displays VOR

· (Freq): displays the frequency of the VOR (if VOR is checked)

· NDB: displays NDB

· (Freq): displays the frequency of the NDB (if NDB is checked)

· FIX: displays fixes

· Depth: see further

· Altitude: see further

· Tracking: plots the course of the aircrafts

· Hands off: see further

· Colors: see further

The Apply button applies the change and closes the Options menu.

To help you:

· “CH Profile” will adapt the profile view screen only if there is a center selected. It is sometimes faster to clear the “Center” combo-box, to select the range, to choose the options (all this without refresh of the screen) and then re-select the center.

· If you wish to refresh your Profile view, click in the “Center” combo-box en press the “Enter” key.

Depth:

This text box allows the controller to input the North and South limit of the Profile view.

Planes, ARP, VOR, NDB and fixes will only be displayed if within those limits.

Altitude:

This combo-box allows the controller to choose the altitude displayed on the screen.

Hands off:

This feature helps two controllers to manage aircraft on the Profile view screen.

When this option is checked in the “Options” menu, the text information of an aircraft is gray the first time it is appears on a Profile view (note that the plane itself is always yellow).

E.g.:

· “CHControl” (on PC1)

· “CHControl 2” (on PC 2)

· Plane “CH-006” (on PC3)

Remark: the name of a server is described in the screen “Server info” (see Server Info chapter).

a) The plane appears grey without server name in his text information. The plane is not controlled.
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This image depicts the aircraft as not controlled.
b) When double-clicked on PC1, the text information becomes yellow and the name of the server PC1 is displayed. On PC2, the text information appears grey and the name of the server PC1 is displayed. If the text information is double-clicked on server PC2, a message appears, stating that another server controls the aircraft.
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The image indicates that the aircraft is controlled by CHControl
c) When double-clicked again on PC1, the text information remains yellow but the name of the server is no longer displayed. On PC2, the text information appears grey and the name of the server PC1 is no longer displayed.
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The aircraft is released by CHControl (current server).
c) When now double-clicked on PC2, the text information becomes yellow and the name of the server PC2 is displayed. On PC1, the text information appears grey and the name of the server PC2 is displayed. If the text information is double-clicked on server PC1, a message appears, saying that another server controls the plane.
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The aircraft is controlled by CHControl 2 (another server).
If a aircraft is handled by a Server and this Server leaves the network, the plane will remain handled by this Server. To free this plane, you must go into the “Aircraft info” form (see Aircraft Info chapter).

Devil Weather

This is the sixth item in the Main menu.

This screen allows the controller to send orders to the aircraft. The Main Server may always send orders to the aircraft. The other server clients may only send orders if allowed by the Security (see Security chapter). The “Send” button of an inactive Server is not enabled.

The screen looks like the picture below:
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The upper part of the screen contains:

· the “Send button”: sends the selected orders to the aircraft: the controller makes his choices and then sends them all together.

· The combo box “Send to”: allows the controller to send orders to “All” aircraft or to one of them selected in the list.

The rest of the screen is the Weather (global) area.

Weather (global) area

Allows the controller to define the weather for the Global area:

· Clouds (3 layers)

· Visibility

· Wind (4 layers)

· Temperature (4 layers)

· Baro

· Precipitation

To create a Wind layer (or another layer):

Fill in the data of all the line: you must provide all the information! (Examples are given in brackets)

Altitude (5000)

Type (Gusty)

Direction (180)

Speed (25)

Turbulence (Light)

Check the “Send” check box before the line.

Click the “Send” button.

To help you out:

· If one item is missing, you will receive a message stating which one is missing.

· If one item is incorrectly filled out (text where numbers are required), you will receive a message stating which one is wrong.

· If you place the mouse on a text box, a “tool tip” will give you some information.

· The period MUST be used as decimal separator. Because CH Server probably communicates between computers with different settings, I decided to not follow the Regional Settings of the computer.

To create another type of layer, use the same procedure.

You may create various layers and send them all together.

To delete layers:

Check the “Clear all layers” check box.

Click the “Send” button.

You may delete one or more layers with one “Send”-action.

You may also create some layers and delete other ones with one “Send”-action.

Remark 1: The CH Server makes only basic input check: it is possible to send unrealistic or unreal data: the results are unpredictable.

Remark 2: For the Cloud layer, some combinations are not accepted by Microsoft Flight Simulator: some of your requests will only be partially executed.

Devil Settings

This is the seventh item in the Main menu.

This screen allows the controller to send orders to the aircraft. The Main Server can always send orders to the aircraft. The other server clients may only send orders if allowed by the Security (see Security chapter). The “Send” button of an inactive Server is not enabled.

The screen looks like the picture below:
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The upper part of the screen contains:

· the “Send button”: sends the selected orders to the aircraft: the controller makes his choices and then sends them all together. The Send button works only for the current tab (see below).

· The combo box “Send to”: allows the controller to send orders to “All” aircraft or to one of them selected in the list.

The rest of the screen is separated in 6 tabs:

· Settings/Failure

· Aircraft situation

· Auto-pilot/Com

· Aircraft control (Engines)

· Aircraft control (Others)

· Sound/Keys

Settings/Failure tab

Allows the controller to define the realism of Microsoft Flight Simulator. It allows to switch on or off the aircraft systems. It creates some failures.

· Realism

· Radios

· Com

· Nav

· ADF

· Transponder

· Systems

· Electrical

· Vacuum

· Pitot

· Instruments

· Airspeed Indicator

· Altimeter

· Turn coordinator

· Attitude Indicator

· Heading Indicator

· Vertical speed Indicator

· Fuel

· Magnetic compas

· Engines Failures

· Engine 1

· Engine 2

· Engine 3

· Engine 4

To modify the status of one of more options:

Check or clear the option.

Click on the “Send” button.

Note: The Settings part will be recorded in Microsoft Flight Simulator. When Microsoft Flight Simulator is closed and restarted, these Settings will always be active. You must restore these Settings.

Aircraft situation

1) Allows the controller to set the aircraft situation

· Latitude

· Longitude

· Altitude MSL

· Heading

· Pitch

· Bank
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To send one or more positions:

Fill out the desired data

Check the “Send” check box

Click the “Send” button

Remark: Heading, Pitch and Bank can only be set when Microsoft Flight Simulator is in "Slew mode".

To help you:

· The period MUST be used as decimal separator. Because CH Server must communicate between computer with different settings, I decided to not follow the Regional Settings of the computer.

Auto-pilot tab/Com

It allows the controller to manage the autopilot of the aircraft and to set the Com frequencies.
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These events can be send on a regular basis: the controller may choose the interval (Once,  1,  5,  10,  15,  30  seconds) in the combo-box in the upper part of the screen. The order will be send on each interval specified or only once if selected.

1)  Autopilot

To send auto-pilot settings:

Select the settings you want to send.

Check the “Send” check box

Eventually, select an interval in the “Send every” combo box

Click the “Send” button.

2) Com frequencies

To send one or more frequencies:

Fill in the desired data

Check the “Send” check box

Click the “Send” button

To cancel a timed order, you must go into the “Aircraft info” form (see Aircraft Info chapter).

To help you:

· The period MUST be used as decimal separator. Because CH Server must communicate with the computer using different settings.

Aircraft controls (Engines)

Allows the controller to modify all controls of the aircraft.

· Throttle of each engine

· Prop advance of each engine

· Mixture of each engine

· Magnetos of each engine

· Fuel quantity of each fuel tank
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Engines are counted from left to right: to modify the settings of the axial engine of a triple-engine aircraft, adapt engine 2.

These events can be send on a regular basis: the controller may choose the interval (Once,  1,  5,  10,  15,  30  seconds) in the combo-box in the upper part of the screen. The order will be sent on each interval specified or only once if selected.

To send an order:

Select the settings for the control you want to send.

Check the “Send” check box

Eventually, select an interval in the “Send every” combo box

Click the “Send” button.

To cancel a timed order, you must go into the “Aircraft info” form (see Aircraft Info chapter).

Note:  The most reliable way to simulate an engine failure is to set the mixture/fuel-flow to zero then set deactivate the setting if you plan on allowing the pilot to restart.  Otherwise it will be a permanent failure until the person’s flight simulator is restarted.

Aircraft controls (Others)

Allows the controller to modify all controls of the aircraft.

· Ailerons

· Elevator

· Rudder

· Trims

· Flaps

· Spoiler

· Gear

· Brakes

· Parking brake

· Smoke

· Pitot heat

· Light (Nav, beacon, landing, Taxi, strobes, panel)
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These events can be send on a regular basis: the controller may choose the interval (Once,  1,  5,  10,  15,  30  seconds) in the combo-box in the upper part of the screen. The order will be sent on each interval specified or only once if selected.

To send an order:

Select the settings for the control you want to send.

Check the “Send” check box

Eventually, select an interval in the “Send every” combo box

Click the “Send” button.

To cancel a timed order, you must go into the “Aircraft info” form (see Aircraft Info chapter).

Sound/Keys tab

1) Sound

It allows the controller to play sound on the plane computer.

(see example below)
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Sound files MUST be on each PLANE COMPUTER in the same folder as CH Client. They must also be on the CH Server computer in the same folder as is CH Server.

CH Server will list the sound files placed in the “CH Server” folder. When you select a file in CH Server, CH Client will play the file with the same name.

You can easily replace the original files with yours.

Remark: Sound files are included on the folder “\CHPrograms\Sound on the “CH Programs” CD-Rom.

You may adjust the volume but sounds played under 80% are not really audible.

To play a sound:

Check the “Play sound” check box

Click on the desired sound

Eventually, adjust the volume

Eventually, select an interval in the “Send every” combo box

Click the “Send” button.

To cancel a timed order, you must go into the “Aircraft info” form (see Aircraft Info chapter).

2) Keys

It allows the controller to send keys or keys combination to the aircraft user’s computer.

The screen looks like below:
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To send one or more keys:

Type the desired key codes

Check the “Send” check box

Click the “Send” button

To cancel a timed order, you must go into the “Aircraft info” form (see Aircraft Info chapter).

To help you out:

· The key code for Shift, Alt and Ctrl are noted just below the “Send keys” text box.

· The key codes are the one used in Visual Basic for the “Sendkeys” command.

A few common key codes are listed here:

	Key
	Code

	Enter
	{Enter}

	Escape
	{Esc}

	F1
	{F1}

	Down arrow
	{Down}

	Up Arrow
	{Up}


Here are some examples:

1) “I” turns on/off the smoke system

2) “$CH{Enter}{Enter}” makes (or replaces) the situation file CH.stn

3) “Y+Z+Z+Z” turns on the slew mode and hides the coordinates

4) “{Down}{Down}{Down}” in slew mode will push the plane back

5) “Y” turns off the slew mode

6) Sending 3 then 4 then 5 simulates a push back sequence

Server Info

This is the fifth item in the menu.

The screen looks like below:
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This form is separated in two areas:

· Server Info

· Server connected

Server info

The Server info area proposes the following text boxes:

· Name (required): the name of the current server; used for Radar Hands-off (see the Radar chapter) and Communication (see the Communication chapter)

· Id (required): the id of the current server; used by the Security system (see the Security chapter)

· Group (required): the name of the group of the current server; used for Communication (see the Communication chapter)

· Frequency (required): the com frequency the current server listen to; used for Communication (see the Communication chapter)

· Host Name (read-only): the host name of the current server; for info

· IP address (read-only): the IP address of the current server; for info

Server connected

This area is only available if you’re the Main Server. The list shows all Servers connected with their status:

· Name: the name of the connected server

· Devil status: the permissions of the connected server (see the Security chapter)

· IP address: the IP address of the connected server; for info

· Host Name: the host name of the connected server; for info

Security

The security system allows the Main Server to check:

· if the CH Client requesting a connection is allowed to do so

· if the CH Server requesting a connection is allowed to do so; and if allowed to, assign a user level to it.

Although all CH Server have a Security table in the CH Database, the login check is only done by the CH Server acting as Main Server.

General

The CH Server acting as Main Server can check the connection request of CH Client and CH Server connecting to him. This login check is done only when active.

To activate the login checking:

· In the Monitoring menu, check Login required.

To de-activate the login checking:

· In the Monitoring menu, un-check Login required.
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CH Client connection checking

When the Security system is activated, the CH Server acting as Main Server will check if the Id sent by a CH Client is stored in the CH Database.

The Id sent by a CH Client is typed in the Id text box of the CH Client user interface 
(see the CH Client Manual further details/see example below:
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· If the Id send by a CH Client is not found in the CH Database, the connection is rejected.

· If the Id send by a CH Client is found in the CH Database and associated with the Pilot User level, the connection is accepted.

· If the Id send by a CH Client is found in the CH Database and associated with another (Not allowed or other) User level, the connection is rejected.

CH Server connection checking

When the Security system is activated, the CH Server acting as Main Server will check if the Id send by a CH Server is stored in the CH Database. For a CH Server, there are 3 User levels:

· Controller: the CH Server can use all features of CH Server except it cannot send nor Devil Weather nor Devil settings orders.

· Devil Weather allowed: the CH Server can use all features of CH Server except it cannot send Devil settings orders.

· Devil Settings allowed: the CH Server can use all features of CH Server.

The Id sent by a CH Server is typed in the Id text box of the Server Info screen (see Server Info chapter).

· If the Id send by a CH Server is not found in the CH Database, the connection is rejected.

· If the Id send by a CH Server is found in the CH Database and associated with the Controller or Devil Weather allowed or Devil Settings allowed User level, the connection is accepted and the User level is assigned to the CH Server.

· If the Id send by a CH Server is found in the CH Database and associated with another (Not allowed or other) User level, the connection is rejected.

User interface

This screen is the eighth item in the menu.

The screen looks like below:
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The screen is divided into 3 areas:

· the List on the left

· the Menu area below

· the Data area on the right

To add a new User:

Click the “New” button: the Data area will display a blank screen.

Fill out the data.

Click the “Save” button to save the new user.

Or

Click the “Cancel” button to discard the new user.

To edit a user:

Click the “Edit” button.

Modify the data.

Click the “Save” button to save your changes.

Or

Click the “Cancel” button to discard the your changes.

Remark 1: During the creation or editing of a user, the List and the Close buttons are disabled. You must first save or cancel your changes before displaying an other user or closing the screen.

Remark 2: There is no possibility to undo changes saved to a user.

To help you out:

· If an item is missing, you will receive a message stating which one is missing.

To delete the current user:

Click the “Delete” button.

Remark: There is no possibility to undelete a deleted user.

Communication

The Communication system allows CH Server to:

· Send messages to CH Servers and CH Clients (thus Microsoft Flight Simulator) on a specific com frequency

· Receive messages from CH Servers and CH Clients (thus Microsoft Flight Simulator) on a specific com frequency

· Send messages to a specific CH Client (thus Microsoft Flight Simulator)

· Send messages to a specific CH Server

· Send messages to a specific group of CH Servers

· Receive messages send by other CH Servers

A message is received by a CH Server if:

· Send on the same com frequency

or

· Send to his name

or

· Send to his group

Frequency, name and group of a CH Server are defined in the Server Info screen (see Server Info chapter).
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General

The CH Server can send and receive messages only if the Communication system is activated. The Communication system can only activate when the CH Server is acting as Main Server or connected to a Main Server.

To activate Communication:

· In the Connection menu, check Communication.

To de-activate Communication:

· In the Connection menu, un-check Communication.
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The Communication system is automatically de-activated by closing the CH Message screen.

CH Message

When the Communication is activated, the CH Message windows appears.

The screen looks like below:
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The screen is divided into 2 areas:

· the Send area on the top

· the Receive area below

Send area

The Send area proposes the following control:

· C button: fills the Send To combo box with the current Frequency of the CH Server (as in the Server Info screen) followed by all names defined in the List item of the Communication section of the CHServer.ini file (see CH Server ini file chapter)

· A button: fills the Send To combo box with "All" followed by the list of all callsigns of the connected CH Clients.

· Send To combo-box: messages will be send to the call-sign, Server name, Server group or Frequency selected or encoded here (see further)

· Message text box : text box for the message to be send (see further)

The Send To combo-box is filled by clicking the C button or the A button.

If filled by the C button, you can select the Frequency, Server Name or Server group to witch you which to send the message. You can too type in the Send To combo-box a Frequency, a Server Name or Server group.

If filled by the A button, you can select the "All" to send the message to all planes or a call-sign to send a message to that specific plane. You cannot type into the Send To combo-box when filled by the A button.

The Message text box is the area where you type your message.

To send a message:

Type your message in the “Send” box

Press Enter to send the message

or

Press Escape to empty the message box without sending the message.

Remark: Messages will appear in Microsoft Flight Simulator even if the “Communication” box is not checked in CH Client.

Receive area

Incoming messages appears in the “Receive” list box (the most recent on the top).

Only the last 15 messages are kept. Previous messages are automatically deleted.

Other features

The “Monitoring” menu allow to activate various features of CH Server:

· Log required: activate the Security system (see Security chapter)

· Log into file: will create a text file named “Chlog.txt”. The following information is written to this file:

· Information sent by planes

· Messages sent by planes and servers

· Full information requests by a server from a plane

· Devil’s orders sent to planes

· Information requested from planes

· Detect Aircraft connection: when activated, a message box will be displayed at each aircraft connection.

· Detect Server connection: when activated, a message box will be displayed at each server connection.

· Crash: you will receive a message if the CH Server detects the crash of a plane. The “Crash detection” of CH server will then be deactivated for 30 seconds to allow Microsoft Flight Simulator to reset the Flight.

· Pause: you will receive a message if the CH Server detects that Microsoft Flight Simulator is in Pause. The “Pause detection” of CH server will then be deactivated for 30 seconds. If after 30 seconds, Microsoft Flight Simulator is still in pause, you will receive a new message, and so on.

· Slew: you will receive a message if the CH Server detects that Microsoft Flight Simulator is in Slew mode. The “Slew detection” of CH server will then be deactivated for 30 seconds. If after 30 seconds, Microsoft Flight Simulator is still in Slew mode, you will receive a new message, and so on.

· Stall: you will receive a message if the CH Server detects a stall of a plane. The “Stall detection” of CH server will then be deactivated for 30 seconds. If after 30 seconds, the plane is still in stall, you will receive a new message, and so on.

· Overspeed: you will receive a message if the CH Server detects that a plane is in overspeed. The “Overspeed detection” of CH server will then be deactivated for 30 seconds. If after 30 seconds, the plane is still in overspeed, you will receive a new message, and so on.

CH Server ini file

You can find the file CHServer.ini in the same folder as the CHServer.exe.

This file contains the following data:

[CHServer]

ServerName=CHControl

ID=CHDevilSettings

Group=CHGroup

Frequency=118.60

Role=Main

Communication=0

LogInfo=0

DetectCrash=1

DetectPause=0

DetectSlew=0

DetectStall=0

DetectOverspeed=0

[Main]

LoginRequired=0

DetectAC=0

DetectServer=0

[Connect]

Host=HCL4

[Communication]

List=CHControl;CHControl2

The meaning of each data is:

· CH Server section

· Server Name: type here your Server Name (if invalid, "CHControl" is used)

· Id: type here your Id (if invalid, "CHDevilSettings" is used)

· Group: type here your group name (if invalid, "CHGroup" is used)

· Frequency: type here your Frequency (if invalid, "118.60" is used)

· Role (valid "Main", "Connect" or blank): type here the role you want for your CH Server (if invalid, blank is used)

· Communication (valid "0", "1" or blank): type here "1" to activate Communication, "0" to de-activate it (if invalid, blank is used)

· LogInfo (valid "0", "1"): type here "1" to activate the logging, "0" to de-activate it (if invalid, "0" is used)

· DetectCrash (valid "0", "1"): type here "1" to activate the Crash detection, "0" to de-activate it (if invalid, "0" is used)

· DetectPause (valid "0", "1"): type here "1" to activate the Pause detection, "0" to de-activate it(if invalid, "0" is used)

· DetectSlew (valid "0", "1"): type here "1" to activate the Slew detection, "0" to de-activate it (if invalid, "0" is used)

· DetectStall (valid "0", "1"): type here "1" to activate the Stall detection, "0" to de-activate it (if invalid, "0" is used)

· DetectOverspeed (valid "0", "1"): type here "1" to activate the Overspeed detection, "0" to de-activate it (if invalid, "0" is used)

· Main section: this section is used only if the item Role in the CH Server section is set to "1"

· LoginRequired (valid "0", "1"): type here "1" to activate the Security system, "0" to de-activate it (if invalid, "0" is used)

· DetectAC (valid "0", "1"): type here "1" to activate the Aircraft connection detection, "0" to de-activate it (if invalid, "0" is used)

· DetectServer (valid "0", "1"): type here "1" to activate the Server connection detection, "0" to de-activate it (if invalid, "0" is used)

· Connect section: this section is used only if the item Role in the CH Server section is set to "0"

· Host: type here the Computer name or the IP address of the Main Server

Those data are used as default values when CH Server is started. After CH Server is started, the value can be changed in the user interface (see above).

Remark: Never modify the headers between "[  ]" or the text before the "=" sign.
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Disclaimer

CH Programs comes with no warranty or claim of fitness or reliability.

CH Programs is distributed AS IS, USE AT YOUR OWN RISK. The author of CH Programs has absolutely no affiliation what so ever with Microsoft® Corporation. Neither the author of CH programs, nor Microsoft Corporation shall be held responsible for any loss of data, down time, loss of revenue or any other direct or indirect damage or claims caused by CH Programs or FILES USED IN CONJUNCTION with CH Programs.

Redistribution Terms

CH Programs is SHAREWARE, and:

· MAY NOT BE sold.

· MAY NOT BE uploaded to, nor archived in, BBSs which charge file download fees.

· MAY NOT BE uploaded to, nor archived in, BBSs which are partly or wholly beneficially owned or operated by a commercial enterprise which is engaged in the sale of computer hardware or software.

· MAY NOT BE redistributed with computer hardware or software for which money is charged.

· MAY NOT BE redistributed by a commercial publisher in any form or under any pretext. 

· MAY NOT BE redistributed on floppy disk, CD-ROM, nor in any other printed or electronic storage form for which money is charged, nor as part of a package for which money is charged. This prohibition includes but is not limited to any form of redistribution for which any type of materials or handling fees are charged.

· MAY NOT BE disassembled, decompiled, decomposed, decoded, nor reverse engineered.

Subject to the exclusions listed above, the archive containing CH Programs may be uploaded to BBSs and otherwise redistributed on a SHAREWARE basis as long as the original contents are not modified in any way.

THERE ARE NO EXCEPTIONS to the redistribution terms stated above without the prior written permission of the author.

Copyrights

The CH Programs carry the following copyright:

Copyright ( 1998-2001 by Claude Hanssens. All rights reserved.

Microsoft® is a registered trademark of Microsoft Corporation.

Microsoft Flight Simulator is a trademark of Microsoft Corporation.
WiZip® is a registered trademark of WinZip Computing, Inc.
FSUIPC.DLL has a copyright ( 1999-2001 by Peter Dowson.
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